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I. Présentation d’Altium Designer  
Altium Designer est un outil complet de développement de produits électroniques incluant :  

� un outil de routage PCB 
� un outil de simulation SPICE 
� un outil de développement FPGA  
� un outil de développement de code embarqué 

 
On peut démarrer ces différents outils depuis la page de démarrage de l’outil. 
 

 
Figure 1 - Page de démarrage du logiciel Altium Des igner 

 
Pour en savoir plus sur le logiciel, reportez vous au site d’Altium : 
http://www.altium.com/products/altiumdesigner/  
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II. Flot de conception d’une carte électronique  
La figure 2 décrit le flot typique de conception d’un circuit imprimé (PCB). Un projet PCB contient 2 
documents : 

� une schématique, décrivant le schéma électrique de l’application. Les composants électriques 
sont représentés par des symboles et reliés par des interconnexions électriques 

� un document PCB, décrivant le placement physique des composants sur la carte et le routage 
des interconnexions 

 

Saisie de la 
schématique

Lien symboles -
empreintes

Vérification électrique 
(ERC)

Création d’un projet PCB

Spécification carte et 
règles de routage

Transfert du schéma sur 
le document PCB

Placement composants/ 
Routage PCB

Vérification routage 
(DRC)

Fichier de sortie

Document de 
schématique

Document de 
routage

 
Figure 2 – Flot de conception d’un circuit imprimé (PCB) 

 
Ces 2 documents sont liés. A chaque composant électronique, on associe un symbole électrique et 
une empreinte sur un circuit imprimé. La première phase consiste à définir le schéma électrique. On 
sélectionne dans une librairie les différents symboles électriques des composants, on leur attribue 
des empreintes et on les relie. Après une validation électrique, le document de routage PCB, qui a été 
au préalable spécifié, est mis à jour en fonction de la schématique. Les empreintes des composants 
sont déposées aléatoirement sur la surface de routage, les interconnexions entre les circuits 
apparaissent sous forme de liens virtuels. Les 2 étapes qui suivent sont : 

� Le placement des composants sur la carte 
� Le routage des interconnexions, qui vont être matérialisées par des lignes métalliques 

 
A la fin de ces 2 phases, une vérification de la correspondance entre le routage et la schématique et 
du respect des règles de routage (DRC) est appliquée fin de valider le design. Une fois le design 
validé, des fichiers de sortie peuvent être produits pour réaliser les différents masques servant à 
fabriquer la carte. Les parties qui vont suivre décrivent comment réaliser ces différentes étapes sous 
Altium Designer.  
 

III. Créer un projet PCB  
Sous Altium Designer, un projet est composé d’un ensemble de documents reliés au design. Les 
projets PCB ont l’extension name.PrjPCB. Il s’agit d’un fichier ASCII listant tous les documents et les 
réglages de sortie (pour l’impression et CAM).  
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Pour créer un nouveau projet, cliquez sur File>New>Project>PCB project  depuis la fenêtre de 
démarrage d’Altium (fig. 1). Renommer le nouveau projet en conservant l’extension .PrjPCB et 
indiquer le chemin d’accès sur le disque, en cliquant sur File>Save Project as . Pour l‘instant, le 
projet est vide, aucun document n’a été ajouté. La prochaine étape consiste à créer la schématique et 
de l’ajouter dans le projet. 
 

IV. Saisie d’une schématique  

1. Création d’une schématique 
On créé une nouvelle schématique en cliquant sur File>New>Schematic . Une feuille de saisie de 
schématique vierge apparaît, nommée Sheet1.SchDoc, qui est automatiquement ajouté au projet 
dans la liste Source documents . On renomme la fiche avec File>Save As . Il est possible d’ajouter 
une schématique existante au projet à l’aide d’un clique droit au dessus du nom du projet dans le 
panneau Projects  et en sélectionnant Add Existing to Project .   

 
Figure 3 – Création d’une nouvelle schématique 

 
Avant de démarrer la saisie de la schématique, il est nécessaire de paramétrer les options de la fiche. 
Aller dans Design>Document Options  puis dans Sheet Options . Sélectionner le format de la fiche 
(exemple : A4). Dans Units , sélectionner le système métrique pour les unités.  
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Figure 4 – Modification des options du document de schématique 

 
Ensuite, il faut configurer les préférences générales de la schématique : Tools>Schematic 
Preferences . Sélectionner par exemple dans la liste de gauche Schematic – Default Primitives  et 
cocher la case Permanent . Terminer en cliquant sur OK. 

2. Saisie de la schématique 
Maintenant, il est possible de saisir une nouvelle schématique. Dans 
un premier temps, il est nécessaire de localiser les composants dans 
les différentes librairies fournies par l’outil, puis de charger ces 
librairies. Cliquez sur Design>Browse Libraries  pour afficher le 
panneau d’exploration des librairies. Le bouton librairie est aussi 
disponible sur le bord droit de la fenêtre. La fenêtre présentée figure 5 
appraît en cliquant sur ce bouton. Il existe différents moyens de 
retrouver un composant : 

� soit en cliquant sur le bouton Search . Une fenêtre de dialogue 
s’ouvre permettant une recherche à partir de quelques critères 

� Soit en cherchant dans le contenu d‘une librairie (par défaut, la 
librairie Miscellaneous est chargée). 

 
Différentes informations sont reliées à chaque composant : un 
symbole, une empreinte, un modèle pour la simulation électrique, 
pour la simulation d’intégrité de signal. 
Pour placer un composant sur la schématique, sélectionnez ce 
composant dans sa librairie, puis appuyez sur le bouton Place . Vous 
pouvez ensuite déplacer le composant qui reste flottant et le placer à 
l’endroit voulu par un simple clic ou en appuyant sur Entrée. Lorsqu’il 
est flottant, on peut le faire tourner à l’aide de la barre d’espace, éditer 
ses propriétés à l’aide de la touche Tab, changer son orientation à 
l’aide de la touche x ou y. 
 

 
Figure 5 – Panneau Libraries 

 
Une fois le composant placé, il est possible d’afficher ses caractéristiques par un double clic, de 
l’effacer en le sélectionnant et en appuyant sur la touche Suppr. Il est possible de faire tourner un 
composant en le sélectionnant et en appuyant sur la barre d’espace (ou en allant dans Edit>Move ).  
En double cliquant sur le composant, on fait apparaître ses propriétés. Dans cette fenêtre, on peut 
éditer et modifier le nom, les valeurs, le boîtier, le brochage et d’autres propriétés. 
 



TP CEM                                                                                                                           Décembre 2011 

A. Boyer 6 

Une fois les composants placés, on peut les connecter. Pour cela, cliquez sur Place>Wire  ou sur le 

bouton . Cliquer ou appuyer sur entrée pour connecter la première extrémité du fil, faites de même 
pour connecter la seconde extrémité. Une fois les composants interconnectés, on peut les déplacer 
sans casser les connexions en cliquant sur Edit>Move>Drag . Vous pouvez le faire en bougeant 
normalement le composant tout en appuyant sur la touche Control. 
Enfin, il faut nommer les nœuds. Pour placer des labels de nœuds, cliquez Place>Net Label  et placer 
le sur le fil à nommer. Une croix rouge apparaît quand le logiciel détecte un nœud à nommer. Vous 
pouvez entrer le nom du label en cliquant sur tab si le label est encore flottant ou en double cliquant 
dessus. 

3. Compilation de la schématique 
Altium propose différents moyens de vérification de la schématique construite (electrical rules, matrice 
de connectivité, comparateur, …). Tout cela se paramètre à partir de Project>Project Options . La 
fenêtre de dialogue ci-dessous s’ouvre, permettant de configurer le rapport d’erreur pour toutes les 
fautes possibles. 

 
Figure 6 – Configuration de la vérification de la s chématique 

 
La fenêtre Error Reporting  permet de configurer le niveau de sévérité d’une violation de connectivité 
donnée. La fenêtre Connection Matrix permet de vérifier les connections électriques entre broches, 
ports ou fiches et de configurer le niveau de sévérité des violations associées. Les carrés de couleur 
indiquent les niveaux de sévérité, qui peuvent être modifiés en cliquant dessus. 
On commence par compiler le projet et vérifier si il y a ou non des erreurs en cliquant sur  
Project>Compile PCB Project . Les éventuels messages d’erreur ou d’avertissement s’affichent dans 
le volet Messages  (qu’on fait apparaître sous la fenêtre de schématique en cliquant sur 
View>Workspace Panels>System>Messages ). S’il n’y a pas eu d’erreurs, le volet Messages reste 
vide.  
Une fois la schématique validée, il est possible de transférer la schématique électrique sur le PCB. 
 
En cliquant sur Reports/Bill of Materials , une fenêtre de dialogue permet de paramétrer le fichier de 
sortie contenant la liste des composants. 
 

V. Routage PCB  
Le routage PCB se fait toujours en étroite relation avec la schématique. La schématique permet de 
définir les connexions électriques entre les différents composants. Pour pouvoir faire le lien entre la 
schématique et le PCB, les composants des librairies sont non seulement définis par un symbole de 
schématique mais aussi par une empreinte de PCB. Une fois la saisie de la schématique terminée et 
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validée, on peut mettre à jour le PCB. Les composants avec leurs empreintes physiques apparaissent 
à la surface du PCB, une connexion virtuelle entre2 composants connectés apparaît entre leurs pads. 
Le routage consiste d’abord à placer les composants puis à router les interconnexions physiques 
entre les composants. Toute modification du routage qui brise la correspondance avec la 
schématique conduit inévitablement à une erreur, qui sera détecté par le logiciel de routage. 

1. Création d’un nouveau document PCB 
 
Avant de transférer le design depuis l’éditeur de 
schématique vers l’éditeur PCB, il faut créer un PCB 
vierge, dont on définti la taille, le nombre de couches, 
les épaisseurs, et les règles de routage. Pour cela, on 
va utiliser le PCB Board Wizard. On y accède en 
retournant dans la fenêtre initiale (fig. 1) Printed 
Circuit Board Design  et cliquez sur PCB Document 
Wizard .  On peut aussi y accéder depuis le volet Files  
à droite de la fenêtre, dans New From Template  et en 
cliquant sur PCB Board Wizard .   
 

 
Figure 7 – PCB Board Wizard 

 
Le PCB Board Wizard offre un ensemble de page permettant de configurer les dimensions de la carte, 
la technologie d’assemblage et quelques règles de conception. L’utilisateur peut naviguer sur ces 
pages à l’aide des boutons Next et Back. 

 
Figure 8 – Création d’un nouveau document PCB avec PCB Board Wizard 

 
Voici les différentes étapes : 

� On commence par définir le système d’unité (métrique).  
� Ensuite, on peut choisir un type de carte prédéfinie. Si vous n’avez pas de type de carte 

prédéfini, sélectionnez Custom .  
� On définit ensuite la forme de la carte et ses dimensions. On paramètre aussi les contours de 

la carte, matérialisé par le keep out layer , qui indiquera sur le routage final le bord de la carte 
et qui aidera à son découpage au moment de la fabrication. En général, le contour défini par le 
keep out layer est placé quelques mm en arrière du bord (1 mm suffit).  

� Puis, on définit le nombre de plan de routage de signaux et d’alimentation. Pour un board 2 
couches, on ne dédie aucun plan à l’alimentation, on n’a que 2 plans de signaux. Pour un 
board 4 couches avec un plan d’alimentation et un plan de masse interne, on sélectionne 2 
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plans de signaux et 2 plans d’alimentation. On définira le type de ces plans plus tard, à l’aide 
de la commande Design / Layer Stack Manager . 

� Ensuite, on définit le style des vias (pour de la fabrication de carte 2 couches, on sélectionnera 
Thru hole Vias Only ), puis la technique de montage des composants : composants montés 
en surface ou traversants.  

� Enfin, on paramètre quelques règles de dessin fondamentales (design rules ) : la largeur 
minimale des pistes, la largeur minimale des vias, le diamètre minimal des trous et 
l’espacement minimal entre 2 pistes. On pourra définir de manière plus précise les règles de 
design un peu plus tard durant le design.  

 
Lorsque toutes ces étapes sont terminées, une fenêtre finale s’affiche indiquant que vous avez 
achevé la définition de votre carte, vous pouvez cliquer sur Finish . La fenêtre ci-dessous s’affiche, 
l’éditeur de PCB vient de s’ouvrir. C’est depuis cet éditeur que nous allons pouvoir router la carte.  

 
Figure 9 – Nouveau document PCB produit avec PCB Bo ard Wizard 

 
Le PCB apparaît en noir sur une feuille blanche, avec les dimensions de la carte autour. Sur la base 
inférieure de l’éditeur apparaissent les couches physiques, mécaniques et de masque qui nous 
permettront de router la carte. Cette présentation ne sera pas très adaptée pendant le routage. Pour 
la modifier, allez dans Design/Board Options . En désélectionnant la case Display Sheet , on 
supprime la feuille. 
A partir de cette fenêtre, on peut aussi configurer la grille (Visible Grid ), c'est-à-dire le quadrillage 
visible sur l’éditeur de PCB, ainsi que la grille électrique (Electrical Grid ). Celui-ci nous aidera durant 
le placement des composants puisque ceux-ci se fixeront automatiquement sur cette grille (Snap 
Grid ).  En général, on configure le champ Visible Grid  avec la valeur de l’espacement entre 2 
broches d’un boîtier. 2.54 mm est une valeur standard. Pour l’ensemble des dimensions des grilles, il 
est préférable d’employer des sous multiples et des multiples d’une même valeur. Si la taille de la 
grille est de 2.54 mm, il convient de fixer la taille de Snap Grid  à 0.254 mm ou 0.127 mm. 
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Figure 10 – Paramétrage des options d’un document P CB 

 
Nous devons définir l’empilement des différentes couches du PCB. Pour cela, on clique sur Design / 
Layer Stack Manager . L’écran ci-dessous s’affiche. Si seulement deux plans de signaux ont été 
définis, la figure ci-dessous ne doit pas inclure les plans Internal Plane 1 et 2. Ils n’apparaissent que 
si on a inclus 2 plans d’alimentation. En cliquant sur Internal Plane 1 ou Internal Plane 2, on peut 
connecter ces plans à un nœud donné (alimentation ou masse de préférence).  

 
Figure 11 – Configuration de l’empilement des diffé rentes couches du PCB 

 
Nous venons de finir le paramétrage de base de la carte. Maintenant, nous allons inclure cette carte 
au projet. On peut commencer par sauvegarder le PCB (extension .PcbDoc). Le fichier apparaît dans 
l’arborescence du projet comme un Free Documents et n’appartient pas encore au projet, même si 
vous l’avez sauvé dans le même répertoire que votre projet. Pour l’inclure dans le projet, dans 
l’arborescence projet, faites un clic droit sur le nom du projet, puis Add Existing To Project  et 
choisissez votre document PCB. Celui-ci sera automatiquement intégré au projet. 

2. Transfert de la schématique sur le document PCB 
Le PCB est pour l’instant vide. Il faut maintenant transférer la schématique à votre document PCB. 
Cette opération va transférer l’ensemble des composants de la schématique à votre PCB, sur lequel 
les empreintes des composants et leurs connexions vont apparaître. Pour cela, retournez sur la 
schématique. Cliquez sur Design/Update PCB Document xxx.PcbDoc . La fenêtre suivante s’ouvre.  
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Figure 12 – Transfert de la schématique vers le doc ument PCB 

 
L’ensemble des composants et des nœuds apparaît. Pour réaliser le transfert, cliquer sur Validate 
Changes  puis Execute Changes . Si tout se passe bien, aucune erreur n’est indiquée sur cette 
fenêtre et on peut la fermer. Des modifications sur la fenêtre apparaissent comme le montre la figure 
12.  

 
Figure 13 – Document PCB après transfert de la sché matique 

 
Les composants sont placés en dehors de la carte. La prochaine opération sera le placement des 
composants, qui va consister à les placer judicieusement sur la carte afin d’optimiser le routage.  

3. Placement des composants 
Pour modifier le zoom sur la carte, vous disposez de commandes dans le menu View  ainsi que des 

icônes , la première sert à voir tout le document, le deuxième à faire à zoom sur une zone 
définie.  
Le contour physique des composants apparaît en blanc (couche Top Overlay ) avec l’empreinte. 
L’ensemble des connexions entre composants non routées apparaît en jaune. On appelle ces 
connexions le chevelu . Pour placer les composants, on les déplace à la souris sur le board. Lors de 
ce déplacement, on peut les faire tourner en appuyant sur la touche ESPACE. En appuyant sur la 
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touche TAB, on accède à leurs propriétés. On pourra ainsi modifier l’empreinte d’un composant si 
celle-ci ne convient pas. On peut aussi accéder aux propriétés d’un composant en double cliquant 
dessus.  
Le placement doit se faire en commençant à imaginer à quoi doit ressembler le routage. Une fois le 
placement achevé, l’éditeur de PCB doit ressembler à quelque chose de similaire à la figure 13. Par 
défaut, les composants se situent sur la face avant de la carte (ou Top Layer). 

 
Figure 14 – Placement des composants 

 

4. Routage de la carte 
Le routage de la carte consiste à relier les composants par des pistes gravées sur une couche 
physique. On dispose de 2 couches ou faces : 

� La face avant ou Top Layer  : en général il s’agit de la face où sont placés les composants 
� La face arrière ou Bottom Layer  : pour des composants traversants, il s’agit en général de la 

face sur laquelle les soudures des broches des composants. 
 
Avant de commencer à router, voyons les différentes couches proposées en cliquant sur 
Design/Board Layers & Colors . On distingue les couches physiques (celles sur lesquelles on va 
effectivement routé) des couches mécaniques et de masque qui vont servir à graver sur les couches 
physiques des indications utiles au concepteur ou au fabricant. On les distingue uniquement parce 
qu’elles n’ont pas le même rôle et parce qu’on ne voudra pas forcément graver l’ensemble des 
indications. Les couches physiques que nous allons employer sont les couches Top Layer et Bottom 
Layer. En décochant une couche, on peut la rendre invisible. 
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Figure 15 – Configuration de la visibilité des couc hes 

 
Le routage doit se faire en respectant un ensemble de contraintes appelées design rules. Altium 
Designer propose de router sous contraintes, c'est-à-dire qu’il vérifie durant le routage si les règles de 
design sont respectées. Pour les configurer, cliquez sur Design/Rules . La fenêtre suivante apparaît. 

 
Figure 16 – Configuration des règles de design 

 
Sur la gauche, toutes les règles de design apparaissent, elles sont configurées par défaut. Les règles 
de design les plus importantes concernent les largeurs des pistes, des vias et les espacements entre 
pistes, vias et plans. Pour créer une nouvelle règle, faites un clique droit dans la liste des règles, au 
dessus de la catégorie où vous voulez la créer, puis sélectionner New Rule . Vous pouvez ensuite 
modifier son nom et la paramétrer. 
Comme le montre la figure 15, on peut configurer les tailles minimales, préférées et maximales d’une 
piste. Lorsqu’on route une piste, elle prendra par défaut la largeur préférée. Si on modifie sa largeur 
et qu’elle est plus grande que la largeur max ou plus petite que la largeur min, Altium indiqueraen 
cours de routage une erreur de design. 
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Il est possible d’attribuer une règle de design à un ou plusieurs nœuds ou à une ou plusieurs couches. 
Par défaut, elle est attribuée à tous les nœuds. Pour cela, vous pouvez cocher les cases All , Net, Net 
Class , Layer , Net and Layer .  
On peut maintenant commencer à router. Pour cela, on commence par sélectionner la couche sur 
laquelle on veut router. On la sélectionne dans la liste située au bas de l’éditeur PCB. Ensuite, on 
choisit le type d’objet à router (piste, vias, pads, arcs, texte) et le mode de routage (routage simple ou 

différentiel) : . Altium propose un routage interactif, c'est-à-dire qu’il 

anticipe la direction que va prendre la piste simplifiant ainsi le routage. On clique sur l’icône  et on 
clique sur un des pads d’un des circuits pour démarrer le routage d’une piste. Lorsqu’on clique à 
nouveau, on termine un segment de la piste et on en démarre un nouveau. Pour terminer le routage 
de la piste, on appuie sur la touche ECHAP. Lorsque le curseur est au dessus d’un pad qui doit être 
relié à la piste, un cercle blanc apparaît et l’entoure. Le routeur interactif vous propose de connecter 
ce pad. Si il détecte une erreur de design ou une violation de connexion, la piste ou le pad change de 
couleur. 

 
Figure 17 – Routage d’une interconnexion 

 
Remarque :  avant de router, assurer vous de la couche sur laquelle se situe le composant. Par 
défaut, il est placé sur le Top Layer. Si vous utilisez un composant traversant, alors la couche de 
routage sera en général le Bottom Layer. Si c’est composant monté en surface, alors la couche de 
routage sera en général le Top Layer. Vous pouvez modifier la couche sur laquelle est montée le 
composant en double cliquant sur le composant pour accéder à ses propriétés.. 
 
Pour supprimer une piste, il suffit de la sélectionner à la souris et d’appuyer sur SUPPR. En double 
cliquant sur une piste, on peut accéder à ses propriétés : nœuds, largeur, couche. Pour passer d’un 

couche à une autre, il est nécessaire de placer un via . Si vous placer un via sur une piste, celui se 
connectera automatiquement à la piste en prenant le nom de son nœud. En double cliquant dessus, 
on peut accéder à ses propriétés et modifier sa largeur et le nœud auquel il est connecté. 

Pour remplir un espace par un plan cuivré, on clique sur l’icône  ou sur Place/Polygon Pour . La 
fenêtre suivante s’ouvre. Elle permet de définir la texture du plan (plein ou hachuré), la couche 
physique, le nœud auquel il est connecté (le plus souvent, masse ou alimentation) et la manière de 
remplir. Les règles de design définissent les espacements entre le plan et les pistes et les vias, les 
connections aux vias reliés à un même nœud.  
 



TP CEM                                                                                                                           Décembre 2011 

A. Boyer 14 

 
Figure 18 – Placement d’un plan métallique 

 
Une fois le remplissage configuré, on trace les contours du polygone sur le PCB et on termine la 
saisie en appuyant sur la touche ESC. Une fois terminé, le plan apparaît. La figure 17 à droite 
présente un exemple de plan connecté à la masse. 

 

5. Validation du routage (DRC) 
Une fois le routage terminé, il convient de s’assurer que les règles de dessin ont été respectées. 
Normalement, le routeur automatique nous indique les violations de règles de design. Cette validation 
s’appelle Design Rule Check (DRC). On y accède en cliquant sur Tool/Design Rule Check .  

 
Figure 19 – Configuration du DRC 

 
A partir de la fenêtre qui s’ouvre (fig. 18), on peut configurer le rapport d’erreurs qui sera généré et les 
erreurs qui seront reportées. Une fois que cela est configuré, on clique sur le bouton Run/Design 
Rule Check . Une fois l’opération de DRC effectuée, le rapport de DRC s’ouvre dans une page HTML. 
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Figure 20 – Rapport de DRC 

 

VI. Création des fichiers de sortie  
Altium propose différents fichiers de sortie standards tels que les fichiers Gerber. Créer un fichier de 
sortie standard est très utile lorsque le designer du PCB envoie son design au fabricant car cela 
assure la compatibilité des formats. Le fabricant pourra vérifier le design avec ces propres outils et 
apporter des modifications. Néanmoins, la fabrication consiste à transférer l’image de chaque couche 
du PCB sur des masques. Une manière simple d’assurer ce transfert est de créer une image à 
l’échelle du PCB.  
 

1. Génération des images des masques 
Pour cela, on va exporter chaque couche au format PDF, à l’aide de l’imprimante PDF. Ces 
documents pourront être directement envoyé à l’impression et générer ainsi les masques. Si on 
réalise un board 2 couches, on réalisera 2 images : une pour la face avant, l’autre pour la face arrière. 
Dans un premier temps, il convient de fixer les paramètres de la page, et notamment de fixer ses 
dimensions. Cette étape est nécessaire pour avoir un dessin à l’échelle. Pour cela, cliquez sur 
File/Page Setup…  Choisissez l’orientation de la page, choisissez un mode de couleur noir et blanc 
(option Mono). Pour avoir un dessin à l’échelle, sélectionnez Scaled Print  dans l’option Scale Mode  
et fixez Scale  à 1. 

 
Figure 21 – Configuration de l’impression du routag e 
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Enfin, cliquez sur le bouton Advanced . La fenêtre ci-dessous apparaît, listant les couches et les 
informations qui seront visibles lors de l’impression. Pour supprimer des couches ou en ajouter, 
appuyez sur le bouton droit de la souris et cliquez sur Delete  ou Insert Layer . Cochez la case Holes 
pour faire apparaître les trous de perçage à l’impression. Cette option n’est utile que pour des 
montages traversants.  

 
Figure 22 – Couches visibles lors de l’impression 

 
Dans le cas d’une carte 2 couches, il convient de : 

� réaliser une première image incluant le Top Layer, le Top Overlay (si on souhaite garder 
l’emplacement des composants sur la face avant) et le Keep-Out Layer (pour afficher le bord 
de la carte) 

� réaliser une seconde image incluant le Bottom Layer, le Bottom Overlay (si on souhaite garder 
l’emplacement des composant sur la face arrière) et le Keep-Out Layer (pour afficher le bord 
de la carte) 

 
Pour vérifier ce qui va être imprimé, cliquez sur File/Print Preview . On obtient l’image suivante. Pour 
la sauvegarder au format PDF, cliquez sur Print  et utilisez l’imprimante PDF. On obtient ainsi le 
masque pour le top layer. 
 

VII. Créer une nouvelle librairie intégrée  
La réalisation d’un PCB commence par une saisie de schématique, qui consiste à interconnecter des 
composants ou des symboles. A ces composants, on peut associer des modèles (SPICE) et des 
empreintes PCB. Les éléments de schématique et d’empreintes PCB sont rangés dans des librairies : 

� Librairie de schématique .schlib 
� Librairie d’empreintes PCB .pcblib 

 
Cependant, il est aussi possible de placer tous ces composants dans une seule librairie afin 
d’améliorer la portabilité du design et d’avoir tous les composants dans un seul et même fichier. Les 
librairies intégrées sont appelées librairie intégrée et leur extension est .intlib.  
Avant de créer une librairie intégrée, il faut créer la librairie de schématique et d’empreintes. Dans un 
premier temps, nous allons créer une librairie de schématique, puis créer une librairie d’empreintes. 
 

1. Créer une librairie de schématique 
Avant de créer des composants de schématique, il nous faut créer une librairie de schématique. 
Celle-ci peut être créer telle quelle, comme une simple collection de composants. Cependant, si on 
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désire la compiler et y intégrer des modèles pour réaliser une librairie intégrée, il nous faut créer un 
nouveau package de librairie .LibPkg. A l’intérieur, on trouvera de manière séparée les librairies de 
schématique, d’empreintes et les modèles de simulation, qui seront finalement compilés au sein d’une 
même librairie intégrée. 
Pour créer le nouveau package de librairie, on clique sur File/New Project/Integrated Library . On 
peut le sauver ensuite et modifier son nom en gardant l’extension .LibPkg. Pour ajouter une nouvelle 
librairie de schématique vide, on clique sur File/New/Library/Schematic Library . On crée ainsi un 
package appelé my_lib.LibPkg et une librairie de schématique appelée 
Schematic_components.SchLib. On obtient l’écran suivant. A droite, on peut visualiser l’arborescence 
du package. On voit que la librairie de schématique est bien incluse dans le package. 

 
Figure 23 – Création d’une nouvelle librairie de co mposants 

 
On décide de créer un nouveau composant : un oscillateur TTL/HCMOS, dont voici le boîtier et le 
brochage. 

 
On crée un nouveau composant en cliquant sur Tools/New Components . La librairie contient par 
défaut un premier composant vide appelé Component_1 visible à droite dans l’arborescence Sch 
Library. Avec Tools/Document Options , on peut modifier les paramètres de grille de l’interface 
graphique ainsi que les unités. On commence par construire le corps du symbole, on ne place pas 
encore les lignes des ports d’E/S. Pour cela, on clqiue sur Place/line . On obtient le résultat suivant.  
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Figure 24 – Création du symbole d’un nouveau compos ant 

 
On ajoute ensuite les broche ou pins. Pour cela, on clique sur Place/Pin . On place les pins en dehors 
du corps. L’extrémité d’une pin est indiquée par un carré vert, celui-ci doit être en dehors du corps. 
Avant de relacher une pin, on peut appuyé sur Tab pour éditer les propriétés d’une pin : on indique le 
nom qui s’affichera, le désignateur, le type électrique et la longueur du segment qui s’affichera. 

 
Figure 25 – Propriétés des broches du nouveau symbo le électrique 

 
 
On place les 4 pins du composant et on obtient le résultat suivant. La liste des pins apparaît à droite. 

 
Figure 26 – Création du symbole électrique d’un nou veau composant 
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Dans la liste des composants de la librairie de schématique, on accède aux propriétés du composant. 
On entre les désignateurs par défaut, la description. En cliquant sur Edit Pins, on peut avoir accès à 
la liste des pins et leurs propriétés. 

 
Figure 27 – Edition des propriétés du nouveau compo sant 

 
En cliquant sur Reports/Component , on obtient un descriptif des pins : 
Component Name : Component_1 
 
Part Count : 2 
 
Part : Crystal 
     Pins - (Normal) : 0 
          Hidden Pins : 
 
Part : Crystal 
     Pins - (Normal) : 4 
          NC             1              Passive 
          GND            7              Power 
          OUT            8              Output 
          VDD            14             Power 
          Hidden Pins :  

 
On peut vérifier que le composant créé ne comporte pas d’erreurs en cliquant sur 
Reports/Component Rule Check . 
La prochaine étape consiste à ajouter des modèles (SPICE ou empreintes PCB) aux composants de 
la schématique. On peut utiliser des modèles et des empreintes qui existent déjà mais on peut aussi 
en créer de nouveaux. 

2. Créer une nouvelle empreinte PCB 
Tout d’abord, il nous faut créer une nouvelle librairie PCB MyPCBLib.PcbLib : File/New/Library/PCB 
Library . L’écran ci-dessous apparaît, avec un nouveau composant PCB par défaut appelé 
PCBCOMPONENT_1. La librairie PCB apparaît dans le package de librairie avec la librairie de 
schématique que nous avons créé tout à l’heure. Sur l’éditeur graphique d’empreinte, le cercle blanc 
indique l’origine. 
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Figure 28 – Création d’un nouveau composant PCB 

 
Plusieurs outils aident à la construction d’une empreinte, comme le PCB Component Wizard auquel 
on accède en cliquant sur Tools/Component Wizard . Nous allons plutôt créer une empreinte 
manuellement. On commence par paramétrer la grille et les unités avec Tools/Library Options . 

Ensuite, on place les pads. Pour cela, on clique sur Place/Pad  ou sur l’icône . Avant de les placer, 
en cliquant sur tab, on peut modifier les propriétés des pads. On place des pads circulaires, de 
diamètre = 2.5 mm, les trous ont un diamètre de 1 mm.  

 
Figure 29 – Edition des propriétés d’une pastille 
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Après avoir placé les 4 pads et modifié leurs propriétés, on dessine le contour du composant, dessiné 

en utilisant la couche Top Overlay. On le construit en utilisant Place/Line ou l’icône . On obtient le 
résultat final suivant.  

 
Figure 30 –Dessin d’un nouveau composant PCB 

 
Il serait encore possible de construire le modèle 3D du composant, mais on va en rester là et revenir 
à la création de la librairie intégrée. 

3. Ajouter une empreinte à un symbole de schématiqu e 
On peut fermer la fenêtre d’éditeur d’empreinte PCB et revenir à la librairie de schématique. Nous 
avions créé une librairie de schématique Schematic_Components.SchLib et un composant appelé 
Component_1. Ce composant ne dispose que d’un symbole qui pourra être inclus dans une 
schématique, mais si on veut l’utiliser pour du design PCB, il faut lui donner une empreinte PCB. Pour 
cela, on clique sur le bouton Add  dans le volet de gauche sous la liste Models. Une fenêtre s’ouvre 
demandant le type de modèle qu’on souhaite ajouter. On sélectionne Footprint. La fenêtre suivante 
s’ouvre. 

 
Figure 31 – Attribution d’une empreinte PCB à un co mposant 
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En cliquant sur Browse, on va chercher la librairie MyPCBLib.PcbLib qu’on a créé, et on sélectionne 
le composant PCBComponent_1. On clique sur OK et l’empreinte PCB est ajoutée comme modèle au 
composant Component_1.  

 
Figure 32 – Nouveau symbole dans une librairie incl uant un symbole électrique et une empreinte PCB 

 

4. Création de la librairie intégrée 
On peut créer d’autres symboles de schématique et leur associer des modèles. Ces composants 
peuvent être inclus dans une même librairie intégrée. Dans notre exemple, nous avons un seul 
composant décrit par son symbole de schématique et une empreinte PCB. Ces éléments sont inclus 
dans les librairies Schematic_Components.SchLib et MyPCBLib.PcbLib, elles-mêmes incluses dans 
un package de librairie appelée My_Lib.LibPkg. Une librairie intégrée sera donc créer à partir de ce 
package.  
Pour cela, on compile le package en cliquant sur Project/Compile Integrated Library . Si la 
compilation se déroule sans erreur, le volet Librairie s’ouvre avec la librairie intégrée nouvellement 
créée qui s’appelle My_Lib.IntLib. Les composants de cette librairie pourront être utilisées pour de la 
saisie de schématique et de PCB. 
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Figure 33– Création d’une nouvelle librairie intégr ée 

 
 


